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1.  Summary of overall project accomplishments as related to the intended outcomes of the 
project described in the proposal. 
 

a. A thorough list of 2003-2004 Capstone courses offered at IUPUI was developed. 
 
b. A collection of syllabi from Capstone courses at IUPUI was compiled. 

 
c. The content of the collected Capstone syllabi was analyzed and the data were aggregated 
and summarized. 

 
d. Faculty members were offered the opportunity to receive a copy of the detailed data 
specific to their course(s).  [See sample coding report, Appendix A.] 

 
e. Project results were disseminated at the 2005 Moore Symposium.   
A public dialog about the project, its findings, and the future role(s) of IUPUI Capstone 
courses in the IUPUI curricula was begun during this session. 

 
f. Information about the project was distributed to all schools via the April 2005 PRAC 
meeting.  [See PowerPoint handout, Appendix B.] 

 
g. Questions concerning some of the original project goals were discussed with PRAC 
members at their April 2005 meeting.   

 
 
2.  Describe data collection methods and provide an analysis of the results. 
 

Collecting the syllabi. 
Using the comprehensive list of IUPUI capstones, individual faculty were contacted 
requesting a copy of the most recent version of their syllabus and permission to share it 
with other faculty.  Some of the syllabi came directly from the instructors, while others 
were obtained with the assistance of departmental secretaries or were copied from 
departmental bulletin boards or websites. 
 

Assessing the data. 
A capstone syllabus content analysis rubric, listing the “9 Keys” and the “6 PULs”, was 
developed.  Syllabi were rated in terms of the degree to which each of the items within 
the rubric was explicitly stated; implied, but not explicitly stated; or not implied and not 
mentioned in the target syllabus. A 3-point scale was used to simplify analyses and 
enhance reliability of ratings. 

 
Results 

Results are provided in Appendix B, which was presented to PRAC at their April 2005 
meeting. 
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3.  Describe any obstacles/challenges encountered. 

a.  The Capstone Faculty Learning Community was dissolved over the summer (2004) so we 
no longer had an advisory group to guide us as obstacles/challenges were encountered or to 
assume responsibility for disseminating the findings. 

b.  We had difficulty obtaining responses from many of the instructors.  While we were able 
to collect all desired syllabi eventually, we did not obtain written permission from each 
instructor to post his/her syllabus electronically.   

c.  We had some difficulty coming up with a "common metric" for evaluating capstones that 
were so disparate and that came from such vastly different disciplines.  

d.  It was difficult sometimes to apply our criteria when we were very unfamiliar with the 
subject area. 

e.  We realized that the original plan for making the syllabus archive available to other 
IUPUI faculty via the Capstone Faculty Learning Community had some problems.   

1) We didn’t know how long this website would exist, since this community had been 
disbanded.  

2) We realized that placing it here would also make it available to the world, and we were 
unsure whether this was a desirable outcome for IUPUI, as the syllabi were the 
intellectual property of the instructors and IUPUI. 

f. We recognized that course syllabi may not accurately reflect the degree to which certain 
principles were present in course content. Our assessment may be negatively skewed because 
we relied exclusively on course syllabi. 
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4.  What changes, if any, were made to address these obstacles/challenges? 

a. We proceeded with the project on our own, making ad hoc decisions, as needed.  We 
decided to at least take the minimal steps of sharing our findings at the 2005 Moore 
Symposium and with PRAC.   

b. If the faculty were unresponsive, we contacted the departmental secretaries and asked for 
their assistance.  We also searched for copies of the syllabi on departmental websites and 
bulletin boards.  We were prepared to leave syllabi out of the study, if the instructors 
indicated that they preferred not to participate, but we did not receive any negative responses. 

c. Some of our original scales had to be modified after viewing the syllabi.  For example 
some capstone experiences involved a sequence of courses or a menu of choices, rather than 
just one course that was taken by all students in the program.  Also, because of the wide 
differences between the courses, we decided to do all of the syllabus-coding ourselves, rather 
than utilizing our clerical assistant. 

d. Some of the information was not present in the syllabi, and we really couldn’t even 
determine if it was implied.  In such cases we spent extensive time combing online bulletins 
or departmental websites to determine if a particular capstone course was required of all 
majors or whether the instructor was a full-time member of the faculty. 

e. We brought this question to the April PRAC meeting.  We learned that there will continue 
to be archive space available for Capstone-related projects like this.  The second question has 
not yet been resolved.  If it is decided that this is still a desirable outcome, written permission 
will still need to be obtained from each of the instructors.   An alternative might be to select a 
few as “exemplary” and only post those, once written permission had been obtained. 

f. PRAC advised us to retain any remaining funds and to continue our work, supplying each 
instructor with the coding sheet for his/her course, and presenting our findings to a wider 
audience. 

NOTE--A printed copy of the summary PowerPoint, prepared for the Moore Symposium, 
was sent to each instructor in March 2005, along with an offer to provide him/her with a copy 
of the coding sheet for their course.  A follow-up email message, making the same offer was 
also sent to each instructor.  Only 5 instructors requested a copy of the coding Data Analysis 
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Appendix A 
Sample Coding Report 

 
Content Analysis of IUPUI Capstone Courses 
 
Coding of syllabus for __________________________________ for semester _______________ 
 
 
PART I.  What type of presence does each “Key” have on the syllabus?  (Explicit? Implicit? Not 
there?) 
Information for the analysis of the “Keys” comes either from the syllabus itself or from information 
accessed via the departmental website, such as the program description, course description, list of 
fulltime faculty, etc. 
 
KEY 1:  Discussion, reflection and/or demonstration of the IUPUI Principles of Undergraduate 
Learning (PUL's) should be evident in the capstone experience. 
 

(3) EXPLICIT - PULs are specifically mentioned 
(2) IMPLICIT - PULs are not specifically mentioned, but there are phrases within the syllabus that 

correspond to the spirit of the PULs (application of knowledge, values and ethics, 
etc.)  

(1): no mention of PULs in syllabus 
 
KEY 2:  The primary focus of the capstone experience should be on synthesis, integration, and 
application of previous knowledge rather than on acquisition of new knowledge and skills. 
 

(3) EXPLICIT - Statement that a goal of the course is the synthesis and application of knowledge 
acquired earlier in the program of study 

(2) IMPLICIT  - Either, Use of class time for discussions, casework, etc. rather than lectures on 
new content, or, Lots of prerequisites are specified 

(1) no mention of synthesis/application/integration of knowledge  
 
KEY 3:  Capstone experiences should be a culminating set of personal, academic, and 
professional experiences. 
 

(3) EXPLICIT – Either, Statement about the “capstone” function of the capstone, or Indication that 
the capstone serves as a bridge between undergraduate curriculum and 
professional (or next phase of) life  

(2) IMPLICIT  - Allusions to role transitions (e.g., via practicum/internship experience/design 
project) 

(1) no mention of culminating set of experiences  
 
KEY 4:  The rationale for the capstone experience should be based on the specific needs of the 
discipline. 

 
(3) EXPLICIT - Statement concerning how the course focuses explicitly on the broader needs of 

the discipline 
(2) IMPLICIT  - Either, Indirect reference to relevance of the course to the broader 

discipline/domain, or, Course is an internship or practicum or design project (ET 
programs) 

(1) no mention of the relevance of the course to the needs of the discipline 
 
KEY 5:  Capstone experiences need not be thought of as a single course. 
 

SINGLE – there is a single capstone course for this department/major 
SEQUENCE - there is a required sequence of capstone courses (usually 2) for this 
department/major 
MENU – there is more than one capstone option for this department/major 
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Appendix A 
 

KEY 6:  Capstone experiences should be structured near the end of the program of study. 
 

(3) EXPLICIT - Any of the following: 
• Statement that the course should be taken after all other requirements have been 

fulfilled 
• 400-level course   
• Senior status is required 

(2) IMPLICIT - Lots of prerequisites are specified, but there is no explicit statement that senior 
standing is necessary 

(1) no prerequisites listed, no statement that senior status is required 
 
KEY 7:  Satisfactory completion of capstone experiences should be required for graduation. 

 
(3) EXPLICIT - Syllabus states that the course is required for graduation.   
(2) IMPLICIT - Syllabus does not state that the course is required for graduation, but it is clear 

from the program description/course description that it is a graduation requirement 
(1) the course is not required for graduation.  

 
KEY 8:  Capstone experiences should be facilitated, mentored, and/or coordinated by full time, 
experienced faculty 
 

YES  - taught/coordinated by FT faculty.  
NO - taught by adjunct/PT faculty 
DK (don’t know) - cannot be determined 
SOMETIMES - responsibility for the course changes/rotates among full-time and adjunct faculty.  

 
KEY 9:  Student ownership, responsibility, and engagement should be central to the capstone 
experience 

 
(3) EXPLICIT - Explicit statement that students’ “ownership of their learning” /“responsibility for 

their own learning” is essential for success in the course 
(2) IMPLICIT - List of assignments and classroom activities clearly aligned with deep 

learning/reflective practices   
(1) No evidence of deep learning/reflective practices in student assignments or classroom 

activities 
 

 
PART II.  Which of the PULs are explicitly mentioned on the syllabus? 
*Communication and quantitative skills (typically PUL #1) were split such that “communication skills” and 

“quantitative skills” were evaluated separately.   
 
Core Communication Skills       (1) YES  (2)  NO 
Quantitative Skills        (1) YES  (2)  NO 
Critical Thinking        (1) YES  (2)  NO 
Integration and Application of Knowledge     (1) YES  (2)  NO 
Intellectual Depth, Breadth, and Adaptiveness     (1) YES  (2)  NO 
Understanding Society and Culture      (1) YES  (2)  NO 
Values and Ethics        (1) YES  (2)  NO 
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Appendix B 
 

PowerPoint Handout presented at PRAC’s April 2005 meeting. 
http://mypage.iu.edu/~rstocker/PRAC-CapstonePresentation-April2005.ppt 

 
 
Printing Notes for Appendix B. 
 

This file is Read-only.   
To print it, first Save a copy and then Open and edit the saved copy in the following way… 
 
Because this handout is easiest to read when printed using a Landscape view with 4 
horizontal slides per page, do the following 4 steps:  
(1) Open the PowerPoint file; (2) Change settings in the Print dialog window (see details, below);  
(3) Change settings in the Page setup window (see details, below); (4) Print the modified file. 
 
Note--These instructions were written for Microsoft Office PowerPoint 2003 for Windows. 
The procedures for making these changes in other versions of PowerPoint might be slightly 
different. 

1) Open your saved copy of the file 
 
2) To change settings in the Print dialog window: 

a. Open the Print window (either press Ctrl+P or use the pull-down menus at the top 
of the window: File > Print ) 

b. Change the following settings: 
i. Upper right hand corner of the screen, Click the Properties button 

1. From the “Layout” tab, select “Landscape” 
ii. Lower left-hand quadrant of the screen, select the following settings 

1. Print what:    Handouts 
2. Slides per page:          4 
3. Order:   Horizontal 

iii. Bottom center portion of the window, check-mark the following settings 
1. Scale to fit paper 
2. Frame slides 
 

3) To change settings in the Page Setup window: 
a. Open the Page Setup window (use the pull-down menus a the top of the window:  

File > Page setup 
b. Change the following setting: 

i. Bottom center portion of the screen, locate the “Notes, Handouts, & 
Outline section”,  

ii. Select Landscape 
 

4)  Save the modified file.  Print the modified file. 
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Capstone PRAC Grant

What is the present status of Capstone 
courses at IUPUI?
– Baseline assessment

Compile inventory of IUPUI Capstone courses
Content analysis of courses 
– based on syllabus content only 



PRAC grant – early Fall, 2004

Course faculty contacted
Course faculty submitted course syllabi



PRAC Grant – late Fall, 2004

Continue to recruit participation
Coding of syllabi
Two dimensions
– Key principles of student experiences for Capstone 

courses at IUPUI
– IUPUI Principles of Undergraduate Learning

84 Syllabi as of 1/05 (thank you!)



PRAC Grant Results: 84 courses analyzed 
(22 capstone experiences without syllabi)
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Key Principles 
of IUPUI Capstone Courses
1. PULs should be evident in Capstone course
2. Focus on synthesis and application 
3. Culminating personal, academic, professional 

experience
4. Rationale based on needs of discipline
5. Need not be thought of as a single course
6. Near the end of the program of study
7. Required for graduation
8. Full time faculty
9. Student ownership and engagement central to course 

experiences



Key 1: Principles of Undergraduate 
Learning should be evident in 
capstone course syllabi
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application 
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Key 5: Need not be thought of as a 
single course
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Key 6: Near the end of the program 
of study
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Key 7: Required for graduation
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Key 8: Taught by full-time faculty
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IUPUI Principles 
of Undergraduate Learning

Core Communication and Quantitative Skills
Critical Thinking
Integration and Application of Knowledge
Intellectual Depth, Breadth, and Adaptiveness
Understanding Society and Culture
Values and Ethics



PUL’s Explicitly Mentioned in the Syllabus
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Significant Changes from the 
Proposal

Capstone Faculty Learning Community was basically 
dissolved over the summer
Kathy Johnson replaced Dolores Hoyt on the project 
team
Unable to obtain most of the syllabi in digital format
Did not end up requesting permission to post each of 
the syllabi to a public website
Syllabi were extremely diverse—making the content 
analysis more difficult
Project account has a positive balance:  $1312.42 

(The project team did all the syllabus coding, saving much clerical 
labor. )


